REFTek™

SOFTWARE RELEASE NOTES

for the

72A Series DAS

REFTek UTILITIES v2.60 through 2.93

August 1998

Document No. 72A-S-003C-00.1
About this document

This document is a compilation of the release notes for the REFTEK utilities code used in 72A series DAS’s. It provides a quick overview of the changes between releases 2.60 and the current release (2.85 2.87 and 2.88 were omitted). The document is a supplement to the REFTEK Software Operations Manual for Utility Programs, which is more comprehensive. You should use the release notes as a guide to identify the major changes. Complimentary documents record the changes made to the DSP code and the CPU code.

Previous editions of the “Software Release Notes” documented software changes made back as far as code version 2.45. Since it is unlikely that the earlier changes are of current interest to the user, the latest edition of the Software Release Notes omits archival information prior to code version 2.60. However, a copy of the previous edition is freely available to a user at any time. Simply contact REFTEK at one of the address shown inside the front cover and request a copy.
This page intentionally left blank.
Utilities Release Notes: PASSCAL Version 2.93 (July 31, 1998).................................................... 1
  1 ALL: Change in method of opening files. ................................................................. 1
  2 NCI: Correction to log file name corruption. .......................................................... 1

Utilities Release Notes: PASSCAL Version 2.90 (December 9, 1997)............................................ 3
  1 FSC: Addition of SCSI Configuration support ......................................................... 3
  2 NCI: Addition of SCSI Configuration support ......................................................... 3
  3 RTPRMCVT: Modification to support SCSI Configuration parameters .................... 4
  4 NCI: Correction of serial port control ................................................................... 3

Utilities Release Notes: PASSCAL Version 2.86 (October 1, 1997)............................................... 7
  1 FSC: Close-aware. .................................................................................................. 7
  2 FSC: DTR control. .................................................................................................. 7
  3 NCI: Close-aware. .................................................................................................. 7
  4 NCI: DTR control .................................................................................................. 7
  5 NCI: Unit ID output ............................................................................................... 8
  6 PCTIME: Hour adjustment across year boundary .................................................. 8
  7 RTPARSE: Close-aware. ......................................................................................... 8
  8 RTCNVRT: Close-aware. ....................................................................................... 8
  9 RTCNVRT: Global QCC file .................................................................................. 8
 10 RTCNVRT: Verbose message control ..................................................................... 8
 11 RTCNVRT: QCC Syntax modification ..................................................................... 8
 12 RTCNVRT: REFTEK 120 support ......................................................................... 8
 13 SRREAD: Close-aware. ....................................................................................... 8
 14 SRREAD: Command line order .......................................................................... 9
 15 SRREAD: Prompt control ................................................................................... 9

Utilities Release Notes: PASSCAL Version 2.84 (October 7, 1996)............................................. 11
  1 SRREAD and SRSCRIPT: Fixed a bug handling the keyboard buffer ................. 11
  2 SRSCRIPT: Fixed a bug in the handling of the port selection command line switch.... 11
  3 PCPWR: Modified to use serial ports and handle more RS232 signals ................. 11
  4 TAIL: New program to output tail (end) portion of a file .................................... 11
  5 FSC and NCI: Fixed bug in printing parameter file to a printer ......................... 11
  6 PCTIME: Lock quality control ........................................................................... 12

Utilities Release Notes: PASSCAL Version 2.83A (June 6, 1996)............................................. 13
  1 RTCNVRT: ....................................................................................................... 13
  2 FSC, NCI: Modified to handle UPS shutdown ...................................................... 13
<table>
<thead>
<tr>
<th>Utilities Release Notes: PASSCAL Version 2.83 (February 23, 1996)</th>
<th>15</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 RTPRMCVT: New program to convert parameter files</td>
<td>15</td>
</tr>
<tr>
<td>2 FSC: Correction to sound option</td>
<td>15</td>
</tr>
<tr>
<td>3 FSC: Corrections to DAS configurations</td>
<td>15</td>
</tr>
<tr>
<td>4 FSC, NCI: Modification to PC serial port delay</td>
<td>15</td>
</tr>
<tr>
<td>5 FSC, NCI: Modification to DAS serial port control</td>
<td>16</td>
</tr>
<tr>
<td>6 FSC, NCI: Correction to misspelled message</td>
<td>16</td>
</tr>
<tr>
<td>7 RTCNVRT: Addition of /T command line switch</td>
<td>16</td>
</tr>
<tr>
<td>8 RTCNVRT: Addition of customer-specific information</td>
<td>16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Utilities Release Notes: PASSCAL Version 2.80A (October 25, 1995)</th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 RTCNVRT: Correction to handling of command line switches</td>
<td>17</td>
</tr>
<tr>
<td>2 PCTIME: Addition of full serial port support</td>
<td>17</td>
</tr>
<tr>
<td>3 NCI: Addition of disk load commands</td>
<td>17</td>
</tr>
<tr>
<td>4 NCI: Modification of SCSI load and SCSI format menus</td>
<td>17</td>
</tr>
<tr>
<td>5 NCI: Modification of tape backup options</td>
<td>17</td>
</tr>
<tr>
<td>6 FSC, NCI: Addition of parameter file qualification</td>
<td>17</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Utilities Release Notes: PASSCAL Version 2.80 (September 21, 1995)</th>
<th>19</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 ALL: Modification of syntax message</td>
<td>19</td>
</tr>
<tr>
<td>2 RTCNVRT: Modification of time list trigger in output log</td>
<td>19</td>
</tr>
<tr>
<td>3 RTCNVRT: Addition of system time in output log</td>
<td>19</td>
</tr>
<tr>
<td>4 RTCNVRT: Modification of default behavior</td>
<td>19</td>
</tr>
<tr>
<td>5 NCI: Addition of support for time list trigger</td>
<td>19</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Utilities Release Notes: PASSCAL Version 2.70 (June 7, 1995)</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 SRREAD: Modification of syntax message</td>
<td>21</td>
</tr>
<tr>
<td>2 SRSCRIPT: Addition of timeout switch</td>
<td>21</td>
</tr>
<tr>
<td>3 FSC: Addition of time list trigger support</td>
<td>21</td>
</tr>
<tr>
<td>4 FSC: Modification of configuration file</td>
<td>21</td>
</tr>
<tr>
<td>5 FSC: Addition of parameter restriction logic</td>
<td>21</td>
</tr>
<tr>
<td>6 FSC: Modification to keystroke support</td>
<td>22</td>
</tr>
<tr>
<td>7 FSC: Addition of forced auto-dump option</td>
<td>22</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Modification of installation routine</td>
<td>23</td>
</tr>
<tr>
<td>2 Addition of SCSI commander program</td>
<td>23</td>
</tr>
<tr>
<td>3 Addition of REF2SUDS program</td>
<td>23</td>
</tr>
<tr>
<td>4 Replacement of serial library routines</td>
<td>23</td>
</tr>
<tr>
<td>5 Modification of location information in .LOG files</td>
<td>24</td>
</tr>
<tr>
<td>6 RTCNVRT: Modification to time tag calculations</td>
<td>24</td>
</tr>
<tr>
<td>7 RTCNVRT: Modification to program abort sequence</td>
<td>24</td>
</tr>
<tr>
<td>8 ASC SCSI: Addition of SCSIRST program</td>
<td>24</td>
</tr>
<tr>
<td>9 ASC SCSI: Removal of SCSI BUS RESET</td>
<td>24</td>
</tr>
<tr>
<td>10 ASC SCSI: Modification to disk format block</td>
<td>24</td>
</tr>
<tr>
<td>11 ASC SCSI: Modification to Sun label values</td>
<td>24</td>
</tr>
</tbody>
</table>

This section lists and describes the functional software modifications made to REFTek Utilities version 2.90 to create version 2.93, as follows:

- **ALL**: Change in method of opening files.
- **NCI**: Correction to log file name corruption.

1 **ALL: Change in method of opening files.**

The method of opening disk files was changed to prevent access problems in a multi-tasking environment. Access collisions (a program opening a file that another program already has open) caused some PCs to lock up and caused others to terminate running programs. The change prevents a file from being opened by more than one program at a time. This change was implemented in all programs that perform file access, including: FSC, NCI, RTPRMCVT, RTCNVRT, CHKFMB, TAIL, STNINFO, SRREAD and SRSRIPT.

2 **NCI: Correction to log file name corruption.**

Previous versions of NCI corrupted the log file name when a parameter set was loaded using the File menu. This prevented NCI from opening and appending to the log file. Under DOS, there was no other adverse effect. However, under other operating systems, this sometimes caused the PC to lock-up or caused communications with network DAS units to slow down. Changes were made to eliminate the corruption of the log file name and to display a message to the user whenever NCI is unable to open the log file.
This page intentionally left blank.
Utilities Release Notes: PASSCAL Version 2.90 (December 9, 1997)

This section lists and describes the functional software modifications made to REFTek Utilities version 2.86 to create version 2.90, as follows:

- **FSC:** Addition of SCSI Configuration support.
- **FSC:** Modification in detecting changed parameters.
- **NCI:** Addition of SCSI Configuration support.
- **NCI:** Correction to serial port control.
- **RTPRMCVT:** Modification to support SCSI Configuration parameters.

1 **FSC: Addition of SCSI Configuration support.**

A SCSI Configuration command has been added to FSC. The SCSI configuration options are considered part of the DAS parameter set. The SCSI configuration options can be accessed from the Edit Menu and from the Data Menu.

When the SCSI configuration options are accessed from the Edit Menu, they are treated just like other DAS parameters. They can be modified and saved in a parameter set without being connected to a DAS.

When the SCSI configuration options are accessed through the Data Menu, a DAS must be connected. FSC queries the connected DAS for its current SCSI configuration information before displaying the options for editing. When the modifications are accepted (F10 is pressed), the new configuration is sent to the DAS. The DAS implements the new SCSI configuration as soon as the command is received, but after any current SCSI operation is complete.

2 **FSC: Modification in detecting changed parameters.**

Previously, FSC would assume the parameters had been changed if any of the parameter editing forms were entered. Now, FSC does not consider the parameters changed unless F10 (accept changes) is pressed while in a parameter editing form.

3 **NCI: Addition of SCSI Configuration support.**

NCI has been modified to accept FSC parameter files that contain the SCSI configuration options.

4 **NCI: Correction of serial port control.**

Previous versions of NCI left the PC serial port open when it should be closed. NCI incorrectly opened Com1 when Mailbox mode (port 0) was selected. NCI left ports open when it terminated. NCI left Com1 open when switching to Com2. The serial ports are now closed properly.
5 RTPRMCVT: Modification to support SCSI Configuration parameters.

RTPRMCVT has been modified to read and write parameter files that contain the SCSI configuration options. When converting older parameter files to the new format, the SCSI configuration options are set to their default values.
This page intentionally left blank.
Utilities Release Notes: PASSCAL Version 2.86 (October 1, 1997)

This section lists and describes the functional software modifications made to REFTEK Utilities version 2.84 to create version 2.86, as follows:

- **FSC**: Close-aware.
- **FSC**: DTR control.
- **NCI**: Close-aware.
- **NCI**: DTR control.
- **NCI**: Unit ID output.
- **PCTIME**: Hour adjustment across year boundary.
- **RTPARSE**: Close-aware.
- **RTCNVRT**: Close-aware.
- **RTCNVRT**: makes global QCC file.
- **RTCNVRT**: Verbose message control.
- **RTCNVRT**: QCC Syntax modification.
- **RTCNVRT**: REFTEK 120 support.
- **SRREAD**: Close-aware.
- **SRREAD**: Command line order.
- **SRREAD**: Prompt control.

1. **FSC**: Close-aware.

   FSC has been modified to be ‘close-aware’. For a description of ‘close-aware’, see the explanation at the end of the notes in this section (page 9).

2. **FSC**: DTR control.

   FSC now asserts DTR when opening a port and de-assert DTR when closing a port. This has no affect on direct communications with a REFTEK 72A-series DAS or REFTEK 112. Some terminal devices require DTR before they will recognize data on the serial port. This change allows the output of FSC to be recognized by other terminal equipment, such as a dumb terminal.

3. **NCI**: Close-aware.

   NCI has been modified to be ‘close-aware’. For a description of ‘close-aware’, see the explanation at the end of these notes. (page 9).

4. **NCI**: DTR control.

   NCI now asserts DTR when opening a port and de-assert DTR when closing a port. This has no affect on direct communications with a REFTEK 72A-series DAS or REFTEK 112. Some terminal devices require DTR before they will recognize data on the serial port. This change allows the output of NCI to be recognized by other terminal equipment, such as a dumb terminal.
5 **NCI: Unit ID output.**

A bug was fixed which caused the unit ID field of commands issued by NCI to contain the wrong value. This only occurred with several specific non-zero unit ID values.

6 **PCTIME: Hour adjustment across year boundary.**

The adjustment of time using the hour offset from UTC was modified to properly handle year boundaries. Problems with previous versions would only be seen on December 31 or January 1, depending on the hour offset being used.

7 **RTPARSE: Close-aware.**

FSC has been modified to be ‘close-aware’. For a description of ‘close-aware’, see the explanation at the end of these notes.

8 **RTCNVRT: Close-aware.**

RTCNVRT has been modified to be ‘close-aware’. For a description of ‘close-aware’, see the explanation at the end of these notes (see page 9).

9 **RTCNVRT: Global QCC file.**

RTCNVRT now creates a .QCC file containing QCC information for all units found in the input file. This is in addition to the QCC file that is created for each unit. All .QCC files are controllable with the /Q command line switch.

10 **RTCNVRT: Verbose message control.**

A command line switch has been added to RTCNVRT to control the messages it outputs. /V+ produces the same messages as previous versions of RTCNVRT. /V- reduces the messages to a display of the number of megabytes of data processed.

11 **RTCNVRT: QCC Syntax modification.**

The usage of the /Q command line switch has been modified. Previously, /QY turned on QCC file output and /QN turned it off. Now, /Q+ can be used in place of /QY and /Q- can be used in place of /QN.

12 **RTCNVRT: REFTEK 120 support.**

Modifications have been made to support fields in the EH, ET, NH and NT recording blocks that are specific to the REFTEK 120 Data Acquisition Unit (DAU) and Central Recording Unit (CRU).

13 **SRREAD: Close-aware.**

FSC has been modified to be ‘close-aware’. For a description of ‘close-aware’, see the explanation at the end of these notes below.
14 **SRREAD: Command line order.**

A bug was fixed in SRREAD which caused it to always use the first entry on the command line as the output filename. Now, the output filename can occur anywhere on the command line.

15 **SRREAD: Prompt control.**

SRREAD displays its parameters and prompts the user to validate them before continuing. The /Y command line switch forces SRREAD to bypass the prompt and assume the settings are correct.

**Close-aware**

DOS programs that are run under Windows 3.x or Windows 95 cannot normally be terminated using the Close button on the window bar or by a ‘close’ message issued by the operating system. DOS programs can be made ‘close-aware’ by adding some system calls that are benign under DOS but responsive under Windows. A DOS program that is ‘close-aware’ can be closed using the Close button on the window bar or by the ‘close’ message issued by the operating system **IF** they were started using a shortcut (Windows 95) or PIF file (Windows 3.1). They will **NOT** shut down if they are started from a command prompt or a batch file in a DOS box.
This page intentionally left blank.
Utilities Release Notes: PASSCAL Version 2.84 (October 7, 1996)

This section of this manual lists and describes the functional software modifications made to REF TEK Utilities version 2.83A to create version 2.84, as follows:

- **SRREAD and SRSCRIPT:** Fixed a bug trying to flush the keyboard buffer.
- **SRSCRIPT:** Fixed a bug in the handling of the port selection command line switch.
- **PCPWR:** Modified to use serial ports and handle more RS232 signals.
- **TAIL:** New program to output tail (end) portion of a file.
- **FSC and NCI:** Fixed bug in printing parameter file to a printer.
- **PCTIME:** Lock quality control.
- **RTCNVRT:** Output of program parameters added.

1. **SRREAD and SRSCRIPT:** Fixed a bug handling the keyboard buffer.

A bug was fixed that sometimes caused the program to hang. While waiting for the transfer to start, the program detects when a key is pressed. Previously, if any key presses were found, the program would get stuck in an infinite loop.

2. **SRSCRIPT:** Fixed a bug in the handling of the port selection command line switch.

A bug was fixed which caused the /c command line switch to be case sensitive. Previously, it only worked when it was typed in lower case.

3. **PCPWR:** Modified to use serial ports and handle more RS232 signals.

This program was modified to use serial port instead of the parallel port signals. It also handles signals such as DCD, RI and DSR. In addition, the program now sets the DOS error level depending on the signal status and action (such as OFF, ON & STATUS) required.

4. **TAIL:** New program to output tail (end) portion of a file.

This program was written to output the end (tail) portion of a file. This is similar to the UNIX version of the tail program, but without the various switches. This program is useful to display the end of a large file. It can also be used to trim growing log files.

5. **FSC and NCI:** Fixed bug in printing parameter file to a printer.

These programs were modified to explicitly print carriage return characters to the printer when printing the parameter file.
6 PCTIME: Lock quality control.

A command line switch has been added to control whether the program observes or ignores the lock quality factor when setting the PC time. By default, the program ignores the lock quality. Using /L+ in the program invocation causes the program to set the time only when the external clock source indicates the clock is locked.
Utilities Release Notes: PASSCAL Version 2.83A (June 6, 1996)

This section of this manual lists and describes the functional software modifications made to REF TEK Utilities version 2.83 to create version 2.83A, as follows:

- RTCNVRT:
- FSC, NCI: Modified to handle UPS shutdown.

1 RTCNVRT:

Correction to Time Tag Error Calculations

2 FSC, NCI: Modified to handle UPS shutdown

Removed the keyboard flush function before exiting the program, as this would cause the program to miss the shutdown command keystrokes sent by the UPS software.
This page intentionally left blank.

This section of this manual lists and describes the functional software modifications made to REF TEK Utilities version 2.80A to create version 2.83, as follows:

- RTPRMCVT: New Program to Convert Parameter Files
- FSC: Correction to Sound Option
- FSC: Corrections to DAS Configurations
- FSC, NCI: Modification to PC Serial Port Delay
- FSC, NCI: Modification to DAS Serial Port Control
- FSC, NCI: Correction to Misspelled Message
- RTCNVRT: Addition of /T Command Line Switch
- RTCNVRT: Addition of Customer-Specific Information

1 RTPRMCVT: New program to convert parameter files

The RTPRMCVT (parameter convert) program reads existing FSC parameter files and outputs a new file that matches the format of the current version of FSC and NCI. A command line option is available to change the output format.

2 FSC: Correction to sound option

A bug was introduced in FSC v2.70 to the sound option of the FSC program. Whenever the FSC Configuration file was saved, the sound option was forced off. This has been corrected.

3 FSC: Corrections to DAS configurations

The DAS Configuration file used by FSC (FSC.DAS) has been modified to correct several errors reported by users. These corrections include:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Modification</th>
</tr>
</thead>
<tbody>
<tr>
<td>020, 021, 022 and 023</td>
<td>Allow 32-bit data format</td>
</tr>
<tr>
<td>023</td>
<td>Correct the channel relays</td>
</tr>
<tr>
<td>060 and 061</td>
<td>Correct the gains</td>
</tr>
<tr>
<td>080</td>
<td>Change the configuration number for the following DASes to configuration 080: 0146, 0150, 0192, 0195, 0229, 0231, 0338, 0344, 0345, 0347, 0358, 0359, 0366, 0381, 0384, 0387, 0388, 0396, 0403, 0418, 0476, 0530, 0552 and 0554.</td>
</tr>
</tbody>
</table>

4 FSC, NCI: Modification to PC serial port delay

Setting the Delay field in the PC Serial Port Configuration to 0 milliseconds causes the PC to overrun the DAS serial port receive capabilities. Therefore, the option of setting the Delay field to 0 milliseconds has been removed. Delay options of 60, 70, 80 and 90 milliseconds have been added.
5  **FSC, NCI: Modification to DAS serial port control**

FSC and NCI no longer provide the option of configuring DAS serial port 0 (the NULL port) or 1 (the TERMINAL port), since the DAS does not allow these ports to be configured, anyway. In addition, the DAS Port Use fields now default to 0 (the NULL port) instead of to 1 (the TERMINAL port).

6  **FSC, NCI: Correction to misspelled message**

A word was misspelled in one of the messages common to FSC and NCI. This has been corrected.

7  **RTCNVRT: Addition of /T command line switch**

The /T command line switch has been added to RTCNVRT. It allows you to ‘trash’ (skip) a requested number of samples at the beginning of each event.

8  **RTCNVRT: Addition of customer-specific information**

Customer-specific information has been added to the end of a few of the PASSCAL recording blocks. RTCNVRT has been modified to identify this information.
Utilities Release Notes: PASSCAL Version 2.80A (October 25, 1995)

This section of this manual lists and describes the functional software modifications made to REF TEK Utilities version 2.80 to create version 2.80A, as follows:

- RTCNVRT: Correction to Handling of Command Line Switches
- PCTIME: Addition of Full Serial Port Support
- NCI: Addition of Disk Load Commands
- NCI: Modification of SCSI Load and SCSI Format Menus
- NCI: Modification of Tape Backup Options
- FSC, NCI: Addition of Parameter File Qualification

1 RTCNVRT: Correction to handling of command line switches

A bug was introduced in v2.80 when the behavior of RTCNVRT was changed. The bug caused some of the command line switches to be ignored. This has been corrected.

2 PCTIME: Addition of full serial port support

Previously, the PCTIME program allowed the selection of a COM port but only operated at 9600 bps, No parity, 8 data bits and 7 stop bits. Now, all of the serial port parameters are configurable, including baud rate(bps), data bits, stop bits, and parity control.

3 NCI: Addition of disk load commands

Menu options were added to issue Disk Load commands to the REFTEK 44D firmware in the REFTEK 112A.

4 NCI: Modification of SCSI load and SCSI format menus

The SCSI Load and SCSI Format menus were modified so that disk 1 is selection 1, disk 2 is selection 2 and the tape drive is selection 3.

5 NCI: Modification of tape backup options

The tape backup options have been modified. The choices are: ON (data automatically backed up to tape), OFF-PRESERVE (no backup, overwrite NOT allowed) and OFF-OVERWRITE (no backup, disk overwrite enabled).

6 FSC, NCI: Addition of parameter file qualification

FSC and NCI will no longer load parameter files that are not in the current parameter file format.
This page intentionally left blank.
Utilities Release Notes: PASSCAL Version 2.80 (September 21, 1995)

This section of this manual lists and describes the functional software modifications made to REF TEK Utilities version 2.70 to create version 2.80, as follows:

- **ALL**: Modification of Syntax Message
- **RTCNVRT**: Modification of Time List Trigger in Output Log
- **RTCNVRT**: Addition of System Time in Output Log
- **RTCNVRT**: Modification of Default Behavior
- **NCI**: Addition of Support for Time List Trigger

1. **ALL: Modification of syntax message**
   All of the command line utility programs now generate a syntax message that provides basic usage information and default behavior.

2. **RTCNVRT: Modification of time list trigger in output log**
   The Time List Trigger parameters are now properly parsed and labeled in the log file created by RTCNVRT.

3. **RTCNVRT: Addition of system time in output log**
   The PC system time is now output at the top of the log file produced by RTCNVRT.

4. **RTCNVRT: Modification of default behavior**
   Previously, RTCNVRT required multiple parameters on the command line invocation and prompted the user for missing parameters. Now, RTCNVRT defaults all of the parameters except the filename. If the filename is not supplied, RTCNVRT produces a syntax message and quits. The new default behavior of RTCNVRT is to only create LOG files, one for each DAS Unit ID it encounters in the input file.

5. **NCI: Addition of support for time list trigger**
   NCI has been modified to properly handle the addition of the Time List Trigger parameters to the parameter files created by FSC.
This page intentionally left blank.
Utilities Release Notes: PASSCAL Version 2.70 (June 7, 1995)

This section of this manual lists and describes the functional software modifications made to REFTEK Utilities version 2.60 to create version 2.70, as follows:

- SRREAD: Modification of Syntax Message
- SRSCRIPT: Addition of Timeout Switch
- FSC: Addition of Time List Trigger Support
- FSC: Modification of Configuration File
- FSC: Addition of Parameter Restriction Logic
- FSC: Modification to Keystroke Support
- FSC: Addition of Forced Auto-Dump Option

1 SRREAD: Modification of syntax message

The syntax message in SRREAD has been modified so that it accurately reflects the program's default values.

2 SRSCRIPT: Addition of timeout switch

A new switch (/Tsecs) has been added which allows the user to vary the amount of time SRSCRIPT will wait for a command response before it terminates. The time is expressed in seconds with a maximum of 32767 seconds. The minimum timeout is three seconds, which is also the default.

3 FSC: Addition of time list trigger support

Support has been added for the new Time List trigger. This trigger is implemented in CPU v2.70 and later. The Time List trigger allows the entry of up to eleven unrelated trigger times for each stream.

4 FSC: Modification of configuration file

The contents of the FSC configuration file (FSC.CFG) have been modified. The field names have been changed from two-letter mnemonics to English words. Several new fields and comment lines have been added, as well. Refer to REFTEK's Operations Tasks Manual "Using FSC Software" for more information.

5 FSC: Addition of parameter restriction logic

FSC has been modified to restrict some parameter choices based on the Unit ID of the DAS for which the parameter set is being created. Information on the configuration of each DAS is located in the file FSC.DAS. This file is required for the restrictions to take effect. The file is readable ASCII text. If incorrect restrictions are encountered by the user, that user should notify Refraction Technology so that corrections can be made. **THE FSC.DAS FILE SHOULD NOT BE MODIFIED BY THE USER UNLESS INSTRUCTED TO DO SO BY REFTEK PERSONNEL.** For more information, refer to REFTEK's Operations Tasks Manual "Using FSC Software".
6  **FSC: Modification to keystroke support**

FSC now responds to alternate keystrokes for the usual function (Fn) keys. In the Main Menu, the regular number keys can be used to select a menu. In addition, CTRL-E (hold down the CONTROL key and press E) can be used in place of the F10 key to confirm a response or save changes to the entries in a form.

7  **FSC: Addition of forced auto-dump option**

An option has been added to the DAS DATA menu which issues the appropriate commands to the DAS to force the DAS to do a destructive copy of RAM to the auto-dump device.

This section of this manual lists and describes the functional software modifications made to REFTEK Utilities version 2.59 to create version 2.60, as follows:

- Modification of Installation Routine
- Addition of SCSI Commander Program
- Addition of REF2SUDS Program
- Replacement of Serial Library Routines
- Modification of Location Information in .LOG Files
- RTCNVRT: Modification to Time Tag Calculations
- RTCNVRT: Modification to Program Abort Sequence
- ASC SCSI: Addition of SCSIRST Program
- ASC SCSI: Removal of SCSI BUS RESET
- ASC SCSI: Modification to Disk Format Block
- ASC SCSI: Modification to Sun Label Values

1 Modification of installation routine

The installation routine for the REFTEK Utility program has been modified. All utility programs are now on one 3.5” high density (1.44 Mb) diskette. The programs have been compressed into a few files which contain related programs. The installation routine allows selective installation.

2 Addition of SCSI commander program

A new program has been added which works with any ASPI-compliant PC SCSI adapter. SCSI Commander (SCSI.EXE) provides much of the functionality of the older ASC-specific utilities in a single executable program. SCSI Commander can be used with an ASC adapter, provided the ASPI manager program, ASPI_ASC.SYS, is loaded in the PC’s CONFIG.SYS file at boot time. A help screen for SCSI Commander is available by running the program with no command line arguments.

3 Addition of REF2SUDS program

A new program has been added which converts PASSCAL data to SUDS format. REF2SUDS can read a file on the local PC disk or it can read PASSCAL-format SCSI devices directly. A help screen is available by running the program with no command line arguments.

4 Replacement of serial library routines

The serial library routines have been replaced. The previous library did not behave correctly when programs were run in a DOS box under Windows. The new library behaves correctly under Windows, as well as on palm-top PCs such as the HP200LX. This change affects FSC, NCI, SRREAD and SRSCRIPT.
5 Modification of location information in .LOG files

The block location information in all log files has been modified. Previously, the block location was limited to five digits. An additional field preceded the block location which was blank for disks but had filemark location information for tape. The two fields have been combined so that all ten digits can be used for disk block locations, i.e. B:1234567890. For tape, the information appears as a four digit mark and a five digit block separated by a colon, i.e. B:0002:12345. This affects SCSILOG and RTCNVRT.

6 RTCNVRT: Modification to time tag calculations

RTCNVRT performs time calculations and flags data blocks whose time tags indicate a time shift has occurred. Previously, some time tags were incorrectly flagged due to overflow conditions in the calculations. These overflow conditions were most likely to occur with compressed data and/or low sample rate data. This has been corrected.

7 RTCNVRT: Modification to program abort sequence

Previous versions of RTCNVRT sometimes garbled some of its output files when the program was aborted by the user. This has been corrected.

8 ASC SCSI: Addition of SCSIRST program

A new program has been added which issues a hard SCSI BUS reset. The SCSIRST program only works with an ASC SCSI adapter.

9 ASC SCSI: Removal of SCSI BUS RESET

The individual SCSI programs written for the ASC SCSI host adapter no longer issue a hard SCSI BUS reset when they start.

10 ASC SCSI: Modification to disk format block

The SCSI programs written for the ASC SCSI host adapter have been modified to set the PEOD and LEOD fields in the disk format block using the same algorithm as the DAS. Previous versions of SCSIFMT and SCUSICOPY set the LEOD field to a value different from the DAS.

11 ASC SCSI: Modification to Sun label values

Modifications have been made to the values written into the Sun label block by the SCSIFMT program. SCSIFMT only works with the ASC SCSI host adapter.